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SHORT ABSTRACT: 
Mass spectrometric characterization of neuropeptides provides sequence, quantitation, and localization information. This optimized workflow is not only useful for neuropeptide studies, but also other endogenous peptides. The protocols provided here describe sample preparation, MS acquisition, MS analysis, and database generation of neuropeptides using LC-ESI-MS, MALDI-MS spotting, and MALDI-MS imaging. 

LONG ABSTRACT: 
Neuropeptides are signaling molecules that regulate almost all physiological and behavioral processes, such as development, reproduction, food intake, and response to external stressors. Yet, the biochemical mechanisms and full complement of neuropeptides and their functional roles remain poorly understood. Characterization of these endogenous peptides is hindered by the immense diversity within this class of signaling molecules. Additionally, neuropeptides are bioactive at concentrations 100x – 1000x lower than that of neurotransmitters and are prone to enzymatic degradation after synaptic release. Mass spectrometry (MS) is a highly sensitive analytical tool that can identify, quantify, and localize analytes without comprehensive a priori knowledge. It is well-suited for globally profiling neuropeptides and aiding in the discovery of novel peptides. Due to the low abundance and high chemical diversity of this class of peptides, several sample preparation methods, MS acquisition parameters, and data analysis strategies have been adapted from proteomics techniques to allow optimal neuropeptide characterization. Here, methods are described for isolating neuropeptides from complex biological tissues for sequence characterization, quantitation, and localization using liquid chromatography (LC)-MS and matrix-assisted laser desorption/ionization (MALDI)-MS. A protocol for preparing a neuropeptide database from the blue crab, Callinectes sapidus, an organism without comprehensive genomic information, is included. These workflows can be adapted to study other classes of endogenous peptides in different species using a variety of instruments.

INTRODUCTION: 
The nervous system is complex and requires a network of neurons to transmit signals throughout an organism. The nervous system coordinates sensory information and biological response. The intricate and convoluted interactions involved in signal transmission require many different signaling molecules such as neurotransmitters, steroids, and neuropeptides. As neuropeptides are the most diverse and potent signaling molecules that play key roles in activating physiological responses to stress and other stimuli, it is of interest to determine their specific role in these physiological processes. Neuropeptide function is related to their amino acid structure, which determines mobility, receptor interaction, and affinity1. Techniques such as histochemistry, which is important because neuropeptides can be synthesized, stored, and released in different regions of the tissue, and electrophysiology has been employed to investigate neuropeptide structure and function2–4, but these methods are limited by throughput and specificity to resolve the vast sequence diversity of neuropeptides. 

Mass spectrometry (MS) enables the high throughput analysis of neuropeptide structure and abundance. This can be performed through different MS techniques, most commonly liquid chromatography-electrospray ionization MS (LC-ESI-MS)5 and matrix-assisted laser desorption/ionization MS (MALDI-MS)6. Utilizing high accuracy mass measurements and MS fragmentation, MS provides the ability to assign amino acid sequence and post-translational modification (PTM) status to neuropeptides from complex mixtures without a priori knowledge to aid in ascertaining their function7,8. In addition to qualitative information, MS enables quantitative information of neuropeptides through label-free quantitation (LFQ) or label-based methods such as isotopic or isobaric labeling9. The main advantages of LFQ include its simplicity, low cost of analysis, and decreased sample preparation steps which can minimize sample loss. However, the disadvantages of LFQ include increased instrument time costs as it requires multiple technical replicates to address quantitative error from run-to-run variability. This also leads to a decreased ability to accurately quantify small variations. Label-based methods are subjected to less systematic variation as multiple samples can be differentially labeled using a variety of stable isotopes, combined into one sample, and analyzed through mass spectrometry simultaneously. This also increases throughput, although isotopic labels can be time consuming and costly to synthesize or purchase. Full scan mass spectra (MS1) spectral complexity also increases as multiplexing increases, which decreases the number of unique neuropeptides able to be fragmented and therefore, identified. Conversely, isobaric labeling does not increase spectral complexity at the MS1 level, although it introduces challenges for low abundance analytes such as neuropeptides. As isobaric quantitation is performed at the fragment ion mass spectra (MS2) level, low-abundance neuropeptides may be unable to be quantified as more abundant matrix components may be selected for fragmentation and those selected may not have high enough abundance to be quantified. With isotopic labeling, quantitation can be performed on every identified peptide.

In addition to identification and quantification, localization information can be obtained by MS through MALDI-MS imaging (MALDI-MSI)10. By rastering a laser across a sample surface, MS spectra can be compiled into a heat map image for each m/z value. Mapping transient neuropeptide signal intensity in different regions across conditions can provide valuable information for function determination11. Localization of neuropeptides is especially important because neuropeptide function may differ depending on location12.

Neuropeptides are found in lower abundance in vivo than other signaling molecules, such as neurotransmitters, and thus require sensitive methods for detection13. This can be achieved through the removal of higher abundance matrix components, such as lipids 11,14. Additional considerations for the analysis of neuropeptides need to be made when compared to common proteomics workflows, mainly because most neuropeptidomic analyses omit enzymatic digestion. This limits software options for neuropeptide data analysis as most were built with algorithms based on proteomics data and protein matches informed by peptide detection. However, many software such as PEAKS15 is more suited to neuropeptide analysis due to their de novo sequencing capabilities. Several factors need to be considered for the analysis of neuropeptides starting from extraction method to MS data analysis.

The protocols described here include methods for sample preparation and dimethyl isotopic labeling, data acquisition, and data analysis of neuropeptides by LC-ESI-MS, MALDI-MS, and MALDI-MSI. Through representative results from several experiments, the utility and ability of these methods to identify, quantify, and localize neuropeptides from blue crabs, Callinectes sapidus, is demonstrated. To better understand the nervous system, model systems are commonly used. Many organisms do not have a fully sequenced genome available, which prevents comprehensive neuropeptide discovery at the peptide level. In order to mitigate this challenge, a protocol for identifying novel neuropeptides and transcriptome mining to generate databases for organisms without complete genome information is included. All protocols presented here can be optimized for neuropeptide samples from any species, as well as applied for the analysis of any endogenous peptides.

PROTOCOL: 

All tissue sampling described was performed in compliance with the University of Wisconsin-Madison guidelines.

1	LC-ESI-MS analysis of neuropeptides 

1.1	Neuropeptide extraction and desalting

1.1.1	Prior to tissue acquisition, prepare acidified methanol (acMeOH) (90:9:1 MeOH:water:acetic acid) as described in16.

1.1.2	Collect brain tissue from the crustacean17 and use forceps to immediately place one tissue each in a 0.6 mL tube containing 20 &#181;L of acMeOH.

NOTE: Tissue dissection protocols vary greatly for different animals and different tissue types, the reader is referred to protocol17 for a detailed description on how to dissect brain tissue and multiple other tissue types from the crustacean. Samples can be stored at -80 &#176;C until use (ideally within 6 months). The volumes described are used for a single brain from Callinectes sapidus. Volumes should be scaled for tissue size. Tissue may be flash frozen immediately without solvent, although this is not recommended as endogenous proteolytic enzymes will not be inhibited and remain active, though at a slower rate when cold.

1.1.3	Add 150 &#181;L of acMeOH to the sample. Set the total sonication time to 24 s, pulse time to 8 s, pause time to 15 s, and amplitude to 50% on an ultrasonic homogenizer and homogenize the samples on ice.

NOTE: There are different homogenization systems available. Adjust the settings and conditions according to sample type and equipment.

1.1.4	Centrifuge the sample at 4 &#176;C at 20,000 x g for 20 min. With a pipette, transfer the supernatant in a tube and dry it in a vacuum concentrator (266 x g, 1 x 10-4 Torr) at approximately 35 &#176;C. 

NOTE: The dried samples can be stored at -80 &#176;C until use (ideally within 6 months). Heating the vacuum concentrator must be performed with caution. While heat shortens the dry time, the sample must be removed from the concentrator immediately after all the liquid has evaporated to minimize peptide degradation. To avoid this, heating may be omitted from this and all subsequent steps.

1.1.5	For desalting, reconstitute the extracted tissue sample in 20 &#181;L of 0.1% formic acid (FA), vortex well, and sonicate in a 37 &#176;C water bath for 1 min. 

NOTE: There are different desalting materials available. Adjust the solutions and volumes according to the resin identity and neuropeptide amount. Total peptide amount may be estimated using a commercial peptide quantitation assay (see Table of Materials).

1.1.6	Apply 0.5 &#181;L of sample to a pH strip to confirm that pH < 4. If the pH is higher, add 1 &#181;L aliquots of 10% FA until pH < 4.

1.1.7	Obtain a 10 &#181;L desalting tip with C18 resin (see Table of Materials).

1.1.8	Centrifuge at 4 &#176;C and 20,000 x g for 30 s. Place the desalting tip on a 20 &#181;L pipette that is set to 15 &#181;L. Once the desalting tip is wet, prevent air from passing through by keeping the pipette depressed when out of solution until it will be discarded.

1.1.9	Follow manufacture protocol18. Prepare a wetting solution containing 100 &#181;L of 50% acetonitrile (ACN), equilibration solution containing 100 &#181;L of 0.1% FA, wash solution containing 100 &#181;L of 0.1% FA, and elution solutions containing 20 &#181;L of 25% ACN/0.1% FA, 20 &#181;L of 50% ACN/0.1% FA, and 20 &#181;L of 75% ACN/0.1% FA. 

1.1.10	Aspirate the sample 10x with wetting solution followed by washing 3x in wash solution, discarding each wash. Elute by aspirating 10x in each of the elution solutions in order of increasing ACN. 

NOTE: Elution fractions can be kept separate or combined for further analyses.

1.1.11	Discard the used desalting tip and dry the eluted neuropeptides in a vacuum concentrator (266 x g, 1 x 10-4 Torr) at approximately 35 &#176;C.

NOTE: This can be stored at -80 &#176;C until use (ideally within 6 months).

1.2	Isotopic labeling of neuropeptides in tissue extract

NOTE: This step is optional and only used when quantification is desired.

1.2.1	Prepare the 2-plex 1:1 isotopic dimethyl labeling solution in a fume hood: 1% CH2OH2 (13.5 &#181;L of stock 37% weight/weight percentage (wt. %) in water solution in 486.5 &#181;L of water), 1% CH2OD2 (25 &#181;L of stock 20 wt. % in water solution in 475 &#181;L of water), and 0.03 M borane pyridine (3.75 &#181;L of stock 8 M solution in 996.25 &#181;L of water).

CAUTION: Formaldehyde is toxic, so all solutions should be kept in a ventilated hood. Wear gloves, a lab coat, eye protection, and impervious footwear. Contact lenses should not be worn when working with this material.

NOTE: There are different isotopic reagents; select the appropriate ones based on sample type and number of labeling channels desired.

1.2.2	Dissolve crude neuropeptide extract in 10 &#181;L of water and sonicate for 10 min.

1.2.3	Add 10 &#181;L of a different isotopic formaldehyde solution (i.e., CH2OH2, CH2OD2, etc.) to each different experimental condition to be measured quantitatively. Vortex to mix well and briefly centrifuge each sample at 2,000 x g.

1.2.4	Add 10 &#181;L of 0.03 M borane pyridine to each sample tube. Vortex to mix well and briefly centrifuge each sample at 2,000 x g.

1.2.5	Incubate the samples for 15 min at 37 &#176;C in a water bath.

1.2.6	Remove the samples from the water bath and add 10 &#181;L of 100 mM ammonium bicarbonate. Vortex to mix well and briefly centrifuge each sample at 2,000 x g.

1.2.7	Combine the labeled samples for one 2-plex sample and dry the neuropeptides in a vacuum concentrator (266 x g, 1 x 10-4 Torr) at approximately 35 &#176;C.

1.2.8	Desalt the labeled neuropeptides by reperforming steps 1.1.5 – 1.1.10 and store them until ready for data acquisition. 

1.3	Data Acquisition

1.3.1	Reconstitute the dried desalted neuropeptides in 12 &#181;L of 3% ACN/0.1% FA, vortex well, sonicate in 37 &#176;C water bath for 1 min, and briefly centrifuge at 2,000 x g. Transfer each sample into autosampler vials.

NOTE: Adjust the sample volume according to neuropeptide amount to a concentration of ~1 &#181;g peptide per &#181;L. Total peptide amount may be estimated using a commercial peptide quantitation assay (see Table of Materials).

1.3.2	Use an autosampler to inject 1 &#181;L of sample into a high-resolution nano-LC-MS/MS instrument (see Table of Materials). 

1.3.3	Use an approximately 15 cm long reversed-phase (RP) C18 column (see Table of Materials) for running the sample with 0.1% FA in water as mobile phase A and 0.1% FA in ACN as mobile phase B. Run the samples with a gradient of 3% - 95% of B at a rate of 300 nL/min for over 11 min.

1.3.4	For the MS instrument used here, use common MS conditions of 2.00 kV for spray voltage and 275 &#176;C for capillary temperature.

1.3.5	Acquire MS spectra in the range of 200 - 2,000 m/z with a resolution of 60,000, automatic gain control (AGC) target of 1 x 106, and max ion injection time (IT) of 150 ms. 

1.3.6	Select the 15 most intense ions (minimum intensity of 3.2 x 104) for higher-energy collision dissociation (HCD) fragmentation using a normalized collision energy of 30, isolation window of 2.0 m/z, resolution of 15,000, an AGC target of 2 x 105, and max IT of 250 ms. 

1.3.7	Set a dynamic exclusion window of 30 s. Exclude ions with a charge of 1 or ≥ 8 and ions with unrecognized charge states.

1.4	Neuropeptide identification and quantification

NOTE: Many software for database searching and peptide quantification (both open-source and commercial) are available. Here, PEAKS Studio (hereafter proteomics software)15 will be used.

1.4.1	Perform database searching using the steps outlined in 1.4.2 – 1.4.6.

1.4.2	 Create a new project and add the LC-MS data selecting None for the enzyme, Orbitrap for the instrument, HCD for the fragment, and data-dependent acquisition (DDA) for acquisition.

NOTE: Select the appropriate parameters based on data acquisition parameters.

1.4.3	Select Identifications and select Correct Precursor [DDA] and Mass only.

1.4.4	Select Database Search and set an error tolerance of 20.0 ppm using monoisotopic mass for precursor mass and 0.02 Da for fragment ion mass, None for enzyme type, Unspecific for digest mode, 100 for max missed cleavages, and the following variable PTMs with the max allowed variable PTM per peptide of 3: Amidation, Oxidation (M), Pyro-glu from E, and Pyro-glu from Q. 

1.4.5	Select the Neuropeptide Database, estimate false discovery rate (FDR) with decoy-fusion.

NOTE: The mass tolerance error should be adjusted to match the data collected. Use the appropriate database for the sample type. When no enzyme is selected, the max missed cleavages parameter does not affect the search. However, a large number of missed cleavages is required if the software does not have the No Enzyme as an option.

1.4.6	If label-free quantification is desired, select Quantification, select Label-Free and set an error tolerance of 20.0 ppm and retention time tolerance of 1.0 min.

1.4.7	Perform precursor ion quantification if step 1.2 for isotopic labeling was performed.

1.4.7.1	Select Quantification, select Precursor Ion Quantification, use a retention time range of 1.0 min, and use an FDR threshold of 1%.

1.4.7.2	Select a preset or custom quantification method from the Select Method drop-down menu. 

1.4.7.3	To create a new custom method, click Window > Configuration > Label Q Method > New. Name the new method and select Precursor Ion Quantification for Method Type. Select Add Row and select modification from the PTM Options list. 

1.4.7.4	Add the LC-MS data and select RefXnce Condition to be the modification on neuropeptides from the control condition of the experiment.

1.4.8	Evaluate the search results as described in steps 1.4.9 – 1.4.11.

1.4.9	Filter the results through the summary tab for peptides and proteins with -10lgP ≥ 20, select ≥ 1 unique peptide, and select box labeled With Significant Peptides.

1.4.10	Evaluate the database search results where Protein.csv represents neuropeptide identifications and Peptide.csv represents neuropeptide fragment identifications.

1.4.11	Inspect the database search for protein and peptide scores, mass accuracy, and sequence coverage.

NOTE: Each database search software uses unique scoring algorithms and may need to be evaluated accordingly. Identifications can be evaluated by manually inspecting the observed spectra for identified peptides containing the complete fragment ion series.

2	MALDI-MS spotting analysis of neuropeptides

2.1	Sample Preparation 

2.1.1	Follow step 1.1 or steps 1.1 – 1.2 if quantification is desired, excluding step 1.2.8 (desalting after isotopic labeling is not required prior to MALDI-MS analysis).

2.1.2	Reconstitute the dried desalted neuropeptides in 5 &#181;L of 0.1% FA, vortex well, sonicate in a 37 &#176;C water bath for 1 min, and briefly centrifuge at 2,000 x g.

2.1.3	For spotting of neuropeptides in crustacean tissues, use 150 mg/mL 2,5-dihydroxybenzoic acid (DHB) in 50% methanol (MeOH)/0.1% FA (v/v) as the matrix.

2.1.4	Pipette a 3 &#181;L droplet of sample onto a hydrophobic film (see Table of Materials) and pipette 3 &#181;L of the matrix directly on the sample droplet. Pipette up and down to mix. 

2.1.5	Pipette 1 &#181;L of the 1:1 sample: matrix mixture into a well of the MALDI stainless steel target plate. Use the pipette tip to spread each mixture out to the edges of the sample well. The sample must touch the edges of the well engraving to facilitate uniform distribution (Figure 4A). 

2.1.6	Spot 1 &#181;L of 1:1 calibrant: matrix mixture (commercial or custom calibration mix, polymer materials (i.e., red phosphorus dissolved in MeOH), or common matrix cluster ions)12 into a well near the sample. 

NOTE: Red phosphorus does not need to be mixed with matrix before spotting.

2.2	Data acquisition

2.2.1	Insert target plate containing dried sample spots into MALDI Tandem Time-of-Flight (TOF/TOF) instrument (see Table of Materials).

2.2.2	Calibrate the instrument and optimize the percent laser power, detector gain, and select the appropriate sample carrier movement mode so that every acquisition covers roughly the entire spot and subsequent acquisitions do not go to the previous positions. 

2.2.3	For DHB matrix set laser power to 95%, select Automatic Optimal Detector Gain, and Smart – Complete Sample sample carrier movement mode. Acquire MS spectra in the range of 200 – 3200 m/z and add multiple spectra from each spot together to increase neuropeptide signal-to-noise ratio. 

NOTE: Adjust the mass range to encompass desired neuropeptide range. 

2.3	Data analysis

2.3.1	Open the MALDI-MS file in data analysis software (see Table of Materials) and click Baseline Subtraction for the software used here.

2.3.2	Perform peak picking by clicking Find Mass List. If there are too few peaks, edit the mass list manually by selecting Edit Mass List and click on peaks in the spectrum to add them to the mass list.

2.3.3	Perform accurate mass matching by comparing mass list with neuropeptide database containing [M+H] + m/z values (&#177; 200 ppm error). 

NOTE: Common salt adducts, such as [M+K]+, [M+Na]+, and [M+NH4]+, should also be included in the accurate mass matching target list. 

2.3.4	To verify the identified peaks, generate a list of m/z of interest and perform MS/MS experiments.

3	MALDI-MS imaging analysis of neuropeptides

3.1	Sample preparation 

NOTE: Embedding and sectioning steps are not necessary for tissues that are too thin to be sectioned. 

3.1.1	Fill half a cryostat cup with gelatin (37 &#176;C, 100 mg/mL in deionized water) and allow it to solidify at room temperature. Keep leftover liquid gelatin warm in a 37 &#176;C water bath.

3.1.2	Collect desired neuronal tissue from the animal and use forceps to immediately dip the tissue into a 0.6 mL tube containing deionized water for 1 s.

NOTE: Refer to Step 1.1.2 NOTE for neuronal tissue dissection. 

3.1.3	Place the tissue on top of the solid gelatin and fill the rest of the cryostat cup with liquid gelatin. Use forceps to position the tissue. 

3.1.4	Place the cryostat cup on a flat surface and freeze with dry ice.

NOTE: Store samples at -80 &#176;C until use (ideally within 6 months).

3.1.5	For sectioning preparation, separate the gelatin-embedded sample from the cryostat mold by cutting the mold away. 

3.1.6	Mount the embedded tissue onto a cryostat chuck by pipetting a 1 mL droplet of deionized water onto the chuck and immediately pressing the embedded tissue onto the droplet. 

3.1.7	Once frozen, pipette more deionized water around the tissue to further secure it to the chuck. Perform these steps inside the cryostat box (see Table of Materials) set at -20 &#176;C. 

3.1.8	Section the tissue at an approximate thickness of one cell (8-20 &#181;m depending on the sample type) and thaw mount each section onto an indium tin oxide (ITO)-coated glass slide by placing one side of the slide near the section and placing a finger on the other side of the slide to slowly warm the glass and allow the section to stick to the slide. 

NOTE: Tissue sections may also be thaw-mounted by picking up one edge of the gelatin with tweezers (chilled to -20 &#176;C), placing it on the ITO-coated glass slide, and placing a finger on the other side of the slide to slowly warm the glass and allow the section to stick to the slide.

3.1.9	Spot the sample to be used as a calibrant (see step 2.1.6 for calibrant options) by drawing a small circle near the tissue section using a hydrophobic pen and spotting the calibrant inside the circle. 

3.1.10	Mark each corner of the slide with a whiteout pen with a small shape containing sharp edges (i.e., x) to be used as teach points. 

3.1.11	Place the glass slide into the MALDI slide adapter plate and take a high resolution (≥2400 DPI) optical image scan using a scanner.

3.1.12	Spray matrix on the tissue section using an automated sprayer (see Table of Materials for sprayer details and instructions).

3.1.13	For MSI of neuropeptides in crustacean tissues use 40 mg/mL DHB in 50% methanol/0.1% FA (v/v) as the matrix, set the nozzle temperature to 80 &#176;C, velocity to 1,250 mm/min, flow rate to 0.1 mL/min, number of passes to 12, and 30 s in between each pass for the automatic sprayer.

3.2	Data acquisition 

3.2.1	Insert the completely dried target plate containing thaw-mounted tissue sections that were sprayed with the matrix.

3.2.2	Set up the MS imaging acquisition file parameters so that the laser diameter is smaller than the raster step size. 

3.2.3	Load the scanned optical image and calibrate the sample plate using the x teach points. Define the tissue areas of interest to be measured slightly larger than the actual tissue section to also include areas containing only matrix. 

3.2.4	Calibrate the instrument and acquire spectra in the range of 200 – 3200 m/z. Adjust the mass range to encompass desired neuropeptide range. 

3.3	    Data analysis

3.3.1	To process data, import MS imaging dataset into desired software, select a baseline removal algorithm, and normalize data using the Total Ion Count.

NOTE: Selection of different normalization algorithms, such as median, root mean square (RMS) value, or the intensity of a reference m/z value, will likely change the spatial distribution of many m/z values. Choose the normalization algorithm best suited for desired analytes. 

3.3.2	To generate an image for each m/z value from a theoretical peak list, upload a comma-separated values (CSV) file containing neuropeptide [M+H]+, [M+Na]+, [M+NH4]+, etc. Obtain m/z values by clicking File > Import > Peak List. Name the peak list.

3.3.3	To estimate the appropriate ppm error threshold, first manually identify a neuropeptide peak in the MS spectrum and compare it with the neuropeptide theoretical mass. Calculate the ppm error and click File > File Properties > Interval Width and input ppm error.

3.3.4	Select the peak list from the drop-down menu and click Create m/z Images For Every Interval of The Peak List. 

3.3.5	Save each m/z image by clicking Save Screenshot of Each m/z Image. 

NOTE: Putative neuropeptide identification can be performed by identifying m/z images where the analyte signal is only localized within the tissue and not in the surrounding matrix.

3.3.6	To verify peak identity, generate a list of m/z of interest and perform MS/MS experiments.

4	Discovering novel putative neuropeptides using de novo sequencing

4.1	   Perform steps 1.4.2 – 1.4.5.

4.2	Export de novo only peptides.csv from peaks with an average of local confidence (ALC) score of≥ 75.

NOTE: There are many software available to perform de novo sequencing, each with its own scoring algorithms and should be evaluated accordingly.

4.3	Search the peptide list for known sequence motifs indicative of neuropeptides belonging to specific neuropeptide families19.

NOTE: While motifs are commonly well conserved across species, the motifs searched for should be selected with consideration to the sample organism.

5	Transcriptome mining for predicted neuropeptide sequences

NOTE: This step is optional and only used to add to an existing neuropeptide database or build a new neuropeptide database. 

5.1	Choose a known preprohormone amino acid sequence of interest and use tBLASTn (http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"BLAST_PROGRAMS=tblastn HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"PAGE_TYPE=BlastSearch HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"SHOW_DEFAULTS=on HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=tblastn&BLAST_PROGRAMS=tblastn&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&LINK_LOC=blasthome"LINK_LOC=blasthome) to search query preprohormone sequence against databases including nr/nt, Refseq_genomes, EST and TSA.

NOTE: To search query sequences against protein database, use BLASTp (http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"BLAST_PROGRAMS=blastp HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"PAGE_TYPE=BlastSearch HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"SHOW_DEFAULTS=on HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"BLAST_SPEC= HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"LINK_LOC=blasttab HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"& HYPERLINK "http://blast.ncbi.nlm.nih.gov/Blast.cgi?PROGRAM=blastp&BLAST_PROGRAMS=blastp&PAGE_TYPE=BlastSearch&SHOW_DEFAULTS=on&BLAST_SPEC=&LINK_LOC=blasttab&LAST_PAGE=tblastn"LAST_PAGE=tblastn).

5.1.1	Select the target organism (tax id) and change Expect Threshold algorithm parameters to 1000 to include low score alignments.

5.1.2	Run BLAST program and then check the results for high homology scores between query and subject sequences producing significant alignments. Save FASTA file containing nucleotide sequence. 

NOTE: If there are several subject sequences with similar homology scores, carry out a MAFFT alignment to narrow down putative sequences20,21. 

5.2	Translate preprohormone nucleotide sequence into preprohormone peptide sequences using Expasy Translate tool (https://web.expasy.org/translate/). For C. sapidus, select Invertebrate Mitochondrial for genetic code.

5.3	Check for signal peptide sequence and prohormone cleavage sites in the peptide sequences using SignalP (https://services.healthtech.dtu.dk/service.php?SignalP-5.0). 

NOTE: Homology to known preprohormone processing schemes can also be used to identify prohormone cleavage sites. Possible post-translational modifications for signal peptides may be predicted if desired. Sulfinator (https://web.expasy.org/sulfinator/) can be used to predict sulfation state of tyrosine residues. DiANNA (http://clavius.bc.edu/~clotelab/DiANNA/) can be used to predict disulfide bond connectivity.

REPRESENTATIVE RESULTS: 
The workflow for sample preparation and MS analysis is depicted in Figure 1. After the dissection of neuronal tissue, homogenization, extraction, and desalting are performed to purify neuropeptide samples. If isotopic label-based quantification is desired, samples are then labeled and desalted once again. The resulting sample is analyzed through LC-MS/MS for neuropeptide identification and quantification. 

Neuropeptides identified through the proteomics software should have good peptide fragmentation sequence coverage, however, this is not globally defined or standardized. For absolute identification, every amino acid should produce a fragment ion that provides unambiguous identification and localization. This must also be compared with a synthesized peptide for confirmation of the intensity of each fragment ion. As the cost for performing this on every putative identification is not feasible, identification is commonly described based on confidence where more observed fragment ions increase peptide identification confidence. While Figure 2A,B depicts two neuropeptides that were both identified with 100% sequence coverage and a low mass error as defined by the max limit of 0.02 Da, the poor fragmentation coverage (from only three ions) observed only for the neuropeptide in Figure 2B decreases the confidence of identification of a specific isoform. Figure 2C depicts the extracted ion chromatograms (XICs), which is a plot containing the signal intensity of a selected m/z value as a function of retention time, of a neuropeptide detected in two samples used for LFQ. The retention times for the neuropeptide differ slightly because it was identified in two separate and consecutive runs; however, the difference is within the reliable threshold value of 1 min. Thus, the ratio between the software-calculated area under the curve from the XIC is used for the LFQ of this neuropeptide. 

For the quantitation of dimethyl labeled neuropeptides, the MS1 spectrum should contain a peak at the theoretical neuropeptide m/z value and a peak at the m/z value with a mass shift that correlates to the mass difference between the isotopic labeling reagents used. In Figure 2D, the mass shift of this 2-plex dimethyl labeled sample is 4.025 Da. The area under the curve of the precursor ion from its XICs is then calculated by the software and used to calculate relative abundance ratios. A simplified version of the proteomics software export table containing identified neuropeptides and their LFQ ratios is shown in Table 1. Similar results are obtained for isotopically labeled neuropeptides.

Software algorithms enable the de novo sequencing of spectra to detect novel putative neuropeptides. When claiming the detection of putative novel neuropeptides, high confidence identifications are ideal cases where all amino acids are identified and localized unambiguously, based on fragment ion observation. Figure 3 depicts the spectrum of a de novo sequenced peptide containing the -RYamide motif at the C-terminal, a conserved sequence motif shared by known neuropeptides of the crustacean RYamide family22. A peptide was matched from the database with 100% sequence coverage, all amino acid forming fragment ions observed, low fragment ion mass error as defined by the max limit of 0.02 Da and contained a gaussian elution profile. These results indicate that an endogenous peptide belonging to the crustacean -RYamide neuropeptide family was observed.

MALDI-MS spot measurements can provide neuropeptide identifications that are complementary to LC-ESI-MS identification, as well as offer higher throughput capabilities. After crude tissue homogenate is extracted for neuropeptides, desalted, and labeled (if desired), the sample can be mixed with matrix and spotted on the MALDI stainless steel target plate, as shown in Figure 4A. Successful pipetting of homogenous sample spots produces clearly resolved peaks, especially within the calibration spectrum (Figure 4B). When using a MALDI-TOF instrument, the instrument must be calibrated at the beginning of each experiment. Any analytes with known masses can be used to calibrate the instrument if it is within the desired mass range of the sample. Here, red phosphorus is used for the positive ion mass calibration of the instrument. It has advantages over using peptide calibration mixes due to its stability at room temperature, cheap cost, abundant peaks due to its polymerization, high signal-to-noise ratio, and it does not require a matrix for ionization. 

For MALDI-MS imaging of neuropeptides, the MALDI TOF/TOF instrument used requires manual image calibration of the ITO-coated slide (step 3.1.10) to correlate the optical image with the sample. The diagram in Figure 5 shows the proper placement of the whiteout crosshairs to be used as teach points to allow the instrument to correlate the scanned optical image with the actual sample plate. It also illustrates areas of the ITO-coated slide that should be avoided by the user (i.e., do not contain sample or matrix). For mass calibration, the placement of the calibration sample spot relative to the tissue sample on the ITO-coated slide directly impacts the mass error due to the inherent nature of time-of-flight mass analyzers, although the magnitude of this issue is dependent on the abundance of the target analytes. A solution to this problem is to manually check peaks from the MS1 spectra from different tissue sections for evidence of peak shifting. If there is peak shifting, consider adding additional mass calibration spots onto the ITO-coated slide right next to each tissue section. From there, the user can average the spectra from the calibration spots together or perform MS imaging on one tissue section at a time using only the calibration spot closest to the tissue section. After the sample is collected, verify that the signal from m/z values corresponding to neuropeptides is only localized within the tissue region (Figure 6) before assigning a putative neuropeptide identification. 

Figure 1: Neuropeptide sample preparation workflow for mass spectrometry analysis. For tissue extract analysis crude tissue homogenate is desalted, labeled with stable isotopic labels, desalted again, and analyzed by MS. For imaging analysis intact tissue is embedded, cryosectioned, applied with matrix, and analyzed by MALDI-MSI. 

Figure 2: Identification and quantification performed through the proteomics software. Neuropeptides are detected through spectra of ranging quality with (A) good or (B) poor MS2 fragmentation coverage. Fragment ion mass matching error is shown below the spectra. (C) XIC profile shapes and retention time (RT) can be manually inspected for neuropeptides quantified through LFQ. (D) MS1 spectra are used to detect and quantify dimethyl labeled neuropeptides.

Figure 3: De novo sequencing for novel neuropeptide detection. (A) The MS2 spectrum of a putative novel RYamide demonstrates good fragmentation coverage with low mass error for each fragment. (B) The identified fragment ions are listed for manual inspection. (C) The XIC of the novel neuropeptide is manually inspected for Gaussian peak shape. Abbreviations: RT = retention time.

Figure 4: MALDI-MS spots and calibration spectrum. (A) MS spectra quality relies on uniform matrix-peptide distribution in the MALDI stainless steel target well. The left three spots are examples of good spots that touch the edges of the well engraving and the right three spots are examples of bad spots. Both spots contain α-Cyano-4-hydroxycinnamic acid (CHCA) matrix and a peptide standard mix. (B) Calibration spectrum using red phosphorus clusters from 500 – 3200 m/z. 

Figure 5: Depiction of ITO-coated glass slide. (A) Schematic with important areas noted: locations to place tissue sections (light blue rectangles), automatic teach points locations that should be avoided (red rectangles), example locations of where teach points may be drawn (white crosshairs), and where screws attach to the adapter plate and should be avoided (dark blue ovals). (B) Photo of glass slide containing two tissue sections, a spot containing a calibration mix, and crosshair marks. The location of the tissue section and calibration spots are outlined on the other side of the glass slide. 

Figure 6: MS images of C. sapidus sinus glands. Neuropeptide [M+H]+ ion distribution images of (A) HL/IGSL/IYRamide (m/z 844.48), (B) Allatostatin A-type NPYAFGLamide or GGPYAFGLamide (m/z 780.40), (C) Allatostatin A-type GQYAFGLamide (m/z 754.39), and (D) RFamide GRNFLRFamide (m/z 908.52) are shown. Images are generated using a &#177; 50 ppm window from the theoretical m/z value. Color bar indicates the range of signal intensity from 0 to 100%. 

Table 1: Database search and LFQ results. Neuropeptides identified and quantified through LC-MS and proteomics software. Identified PTMs are listed along with the intensities of detected peptides in both samples for LFQ, along with the resulting LFQ ratio. The average masses and observed neuropeptide descriptions from the FASTA file are listed.

DISCUSSION: 
The accurate identification, quantification, and localization of neuropeptides and endogenous peptides found in the nervous system are crucial toward understanding their function23,24. Mass spectrometry is a powerful technique that can allow all of this to be accomplished, even in organisms without a fully sequenced genome. The ability of this protocol to detect, quantify, and localize neuropeptides from tissue collected from C. sapidus through a combination of LC-ESI- and MALDI- MS is demonstrated.

During sample preparation for LC-ESI-MS analysis, considerations must be made. While MS is a sensitive technique, the low peptide concentration of neuronal tissue (down to the femtomolar range25) poses a serious limitation. Careful sample preparation is required to not only remove more abundant and interfering matrix components, such as proteins and lipids but also minimize the loss of neuropeptides in each step26,27. For example, sample loss can be reduced by using microcentrifuge tubes that resist peptide adsorption. Depending on the composition of the tissue of interest, the use of various solvents (for extraction or precipitation) or solid-phase extraction materials can be used for separating biomolecules with different sizes and chemical properties. To ensure hydrophilic or hydrophobic peptides are present in the neuropeptide extract, multiple extraction solvent systems may be optionally used to target neuropeptides with different physicochemical properties. These, along with the use of protease inhibitors, may need to be modified for optimized purification to improve neuropeptide recovery28. The drawback of using multiple extraction systems is that several neuronal tissues need to be pooled to meet an overall higher peptide content requirement, as well as decreased throughput. Many steps such as desalting, isotopic labeling, and MS injection recommend certain starting peptide amounts. For the characterization of precious samples, such as neuropeptides, peptide assays are generally avoided to prevent extraneous peptide consumption. Additionally, peptide assays were developed to determine accurate peptide concentration from protein digests, which have different chemical properties than endogenous peptides. To overcome complications from unknown neuropeptide concentration, an initial peptide assay can be performed using pooled neuronal tissue extracts, where the results are used as an estimate for all subsequent analyses, although it must be kept in mind that all peptides in solution are measured, and not all of these are neuropeptides29. Other limitations of this method include potential biases to nonpolar and hydrophobic neuropeptides and the lack of native structure conservation. Modifications to solvent compositions and materials, such as using solutions that are more hydrophobic or omitting the use of organic solvents, may be performed to address this. 

MALDI-MS measurements rely on careful sample preparation steps for consistent results and can have different sample considerations than for LC-ESI-MS measurements. Steps such as keeping neuropeptide extract on ice prior to MS analysis are still applied. Additional methods of preventing neuropeptide degradation include keeping glass slides containing thaw-mounted tissue sections in a desiccant box after dissection to prevent condensation from accumulating30, although leaving the tissue sample in the desiccator after it has dried may result in sample degradation as well. Placing the tissue slides in a vacuum desiccator (final pressure: 1x10-4 Torr at room temperature) for 5–10 min immediately prior to matrix application is suggested. After the matrix is deposited onto the tissue slide, it can be kept in the refrigerator or freezer overnight and dried in the vacuum desiccator prior to MALDI-MS imaging measurement. For MALDI spot measurements, the matrix-peptide crystal structure is not equally distributed throughout the MALDI target well even if it appears so. There are ways to mitigate mass spectra variations from technical replicates due to this process. First, acquire an average spectrum from each well using multiple laser shots (typically hundreds to thousands) where the laser is randomly rastered across the well (i.e., selecting SMART or Random sample carrier movement in instrument parameters). Acquire at least five technical replicates for each sample type and select three technical replicates where the variation in signal intensity for desired peaks is the lowest. The tradeoff here is experimental throughput. It is necessary to keep parameters such as the number of laser shots, laser diameter, and other instrument settings consistent for all acquired spectra. Ideally, all technical replicates and biological replicates are analyzed at the same time using the same matrix solution and instrument calibration. Neuropeptide identification can be performed by accurate mass matching to a peak list containing theoretical [M+H]+, [M+Na]+, [M+NH4]+, [M+K]+, and other salt adducts producing singly charged ion m/z values. Normalization of data is critical for minimizing systematic artifacts from MALDI-MS experiments. Evaluation of reproducibility is especially important when MALDI-MS spot measurements are used for neuropeptide quantification by stable isotope labeling (SIL). Quality of sample preparation and data acquisition can be evaluated by taking a peptide standard or neuropeptide extract, splitting it into two equal aliquots, differentially labeling each sample by SIL, and analyzing the sample to ensure the relative intensity of paired peaks are 1:1. The variation reported from those ratios can be used to estimate the level of variance in the overall experiment attributed to user error. 

It is important to note that MALDI-MS is also capable of providing sequence and quantitative information; however, the singly charged ions produced by MALDI limit peptide fragment detection, making it more difficult to obtain the complete sequence and inhibiting the quantitation methods discussed for LC-ESI-MS. Regardless, MALDI-MS is an attractive modality due to its capability for high throughput, as well as a higher tolerance for salts and impurities within the sample12,31. Additionally, MALDI-MS imaging has advantages over other conventional imaging techniques that require antibodies. In most MS modalities, lowering the mass resolution will boost sensitivity, enabling improved detection of low abundance neuropeptides. This strategy may be more practical for MALDI-TOF/TOF instruments than LC-ESI-MS instruments due to the ease of calibrating the MALDI instrument for each experiment. Another way that MALDI can be advantageous for neuropeptidomics is through spectra averaging. Typically, averaging spectra from LC-ESI-MS measurements is not used because it negates the benefits of LC separation; therefore, bioinformatics software is heavily relied upon to identify neuropeptides and the identifications are manually verified. However, there are fewer consequences for averaging spectra from MALDI-MS measurements because there was no initial separation; therefore, the raw data is smaller and easier for a user to manually comb through. Ease of data management is important as it changes the order in which the user can approach neuropeptide identification and verification strategies. While confidence in neuropeptide identifications from LC-ESI-MS could benefit from increasing the level of threshold stringency within data analysis software, this strategy is less likely to benefit MALDI-MS identifications. In the example of crustacean neuropeptides, the fact that there are less than 1000 entries from the lab-built database (i.e., a maximum of <1000 spectral peaks or MS images to manually scan through), makes it possible to first filter the MALDI-MS data with a generous mass error threshold, and then manually verify those identifications by examining the isotopic envelopes at the MS1 level, as well as other verification methods discussed in the ReprXe Results section. Popular MS imaging data analysis software can perform accurate mass matching to a neuropeptide mass database and extract the corresponding MS images. For clinical-based research questions, such as biomarker discovery, these software are able to extract m/z values unique to a tissue region of interest (typically called Region of Interest (ROI) analysis)32 and perform statistical tests to quantify how different two tissue regions are. It is also worth noting there are also fewer data analysis software options for MS imaging than for LC-ESI-MS.

Performing LC-ESI-MS database searches for neuropeptides commonly entails the use of software algorithms built for the analysis of digested peptides. As such, there are limitations to software being able to perform nonspecific enzyme database searches or the amount of time it takes to complete the search. Currently, endogenous peptide searches are performed with the maximum number of missed cleavages, but this number is still limited, leading to potentially missed identifications. When the genome for a species is not fully sequenced, as with C. Sapidus, de novo sequencing can be performed to identify unknown/ novel neuropeptides through known conserved neuropeptide sequence motifs, although this method fails to identify neuropeptides that have unknown motifs or do not contain the motifs used as neuropeptide family identifiers19. For example, WSSMRGAWamide is a motif for the allatostatin B-type neuropeptide family19. Here lies the significance of transcriptome mining for predicted neuropeptide sequences for species without a completely decoded genome sequence33. Neuropeptide identifications are then confirmed by synthesizing the putative peptide sequence and comparing the MS/MS spectra from synthetic peptide and biological tissue34. Even after a sequence is verified, it is sometimes unknown whether it is the full neuropeptide sequence or a degradation product. It is worth noting that differences between MALDI and ESI-MS ionization sources (ESI is a softer ionization method than MALDI) may result in different rates of artificial degradation (i.e., in-source fragmentation). To distinguish between a truncated version of a peptide from an artificially induced (i.e., not in vivo) degradation product, the preprohormone processing pathway for that neuropeptide must be known. Since this is often not the case, a synthetic form of the peptide should be used in physiological assays and verified for biological activity.

Overall, the workflow exemplified here for neuropeptide analysis can benefit a variety of different fields. It fills a technical gap within middle-down MS analysis of peptides because it is optimized for endogenous peptides that are smaller than proteins typically analyzed by bottom-up or top-down MS analyses. Therefore, the sample preparation methods utilized by neuropeptidomics should be largely translatable to other bioactive endogenous peptides, such as those targeted by medicinal chemists for antibacterial properties35. A benefit of this protocol is that it utilizes common instruments from popular vendors offering an additional degree of translatability as well. In this way, the workflow can be used in academic and commercial settings, such as screening for pharmaceutical drug candidates or drug targets. 
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